Operating Instructions
Video Wall Adjustment & Calibration Software
Video Wall Manager Ver. 1.15

Windows

Thank you for purchasing this Panasonic product.
■ Before using this software, please read the instructions carefully.
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Precautions and Disclaimers
zz Precautions regarding security
	When using the Video Wall Adjustment & Calibration Software, security breaches of the type described below are
conceivable.
zz Leakage of your private information via this software
zz Illegal operation of this software by a malicious third-party
zz Harm to or cessation of operation of this software by a malicious third-party
Be sure to implement sufficient security measures.
zz Make sure the password is as hard to guess as possible.
zz Change the password periodically.
zz Panasonic Connect Co., Ltd. and its affiliated companies never directly ask customers for their password. Do not give out
your password even if directly asked by a third-party representing themselves as Panasonic Connect Co., Ltd.
zz Always use on a network that has safety protection such as a firewall implemented.
zz Set the password for the computer you are using in order to set limits on user accessibility.
zz This software makes use of the following software.
A portion of this software is based in part on the work of the Independent JPEG Group.
zz “Video Wall” and “Multi Screen Display” refer to large screen displays consisting of multiple screens.
zz The illustrations and display examples used in this manual may differ from the actual product.
zz Panasonic Connect Co., Ltd. cannot be held liable for damages arising from data corruption or loss as a result of using this
display.
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What You Can Do with Video Wall Manager
With this software you can use a single computer to manage multiple displays individually or simultaneously without switching
the cable connection.

 Picture Adjustment
You can adjust picture color, density, and white balance.

 Calibration
Using a color sensor, you can adjust the display color, brightness, and gamma.

Note
zz Use a color sensor when calibrating the display.

 Auto Display Adjustment (AUTO ADJUST)
Using an externally-connected camera, you can automatically adjust the color and brightness across multiple displays that
make a Multi Screen Display.

Note
zz In order to use the Auto Display Adjustment function, you must first activate this software, and apply the “Auto Display
Adjustment Upgrade Kit (TY-VUK10)”.
zz To use the Auto Display Adjustment function, prepare a camera.

 Other functions
Some of the display’s menu operations can be carried out on a computer screen.
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Check Your Computer
System requirements
The computer must meet the following requirements in order to use the supplied software.
OS : Microsoft Windows 11
Windows 11 Pro 64bit
		
Windows 10 Windows 10 32/64bit, Windows 10 Pro 32/64bit
		
Windows 8.1 Windows 8.1 32/64bit, Windows 8.1 Pro 32/64bit
		
Compatible with English, Japanese or Chinese language versions of the above operating systems.
		
• For a 64bit OS, this application runs on WOW64.
CPU:
Clock speed of 1 GHz or higher
Memory:
32bit OS: 2 GB or more
		
64bit OS: 4 GB or more
Available disk space:
		
16 GB or greater (Further available space is necessary to save display information)
Others:
A display with a resolution of 1 024 × 768 pixel or higher using High Color (16 bit) or higher
		LAN port for a wired LAN (10Base-T/100Base-TX/1000Base-T) or a serial port (RS-232C compliant)
		
USB2.0-compatible port or higher (when using the calibration and Auto Display Adjustment function)

Note
zz Please understand that operation is not guaranteed if this software application is used in a system environment other than
that specified above or on a home-built computer.
zz The software will not operate properly when a “Guest” account is used. Use a “Standard User” or “Administrator” account.
zz For details on the operating systems supported by the color sensor that will perform calibration, consult the manufacturer of
the color sensor.
Proper operation cannot be guaranteed for all computers even if they satisfy the above requirements.
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Check Your Computer

Necessary Environment for Computers to be Connected
Be sure to check the following settings when connecting the display to the computer.
When using a LAN cable
Computer with a built-in LAN function
- Is your LAN switched on?
Computer without a built-in LAN function
- Is your LAN adapter properly recognized?
Please install the LAN adapter driver beforehand.
For details on how to install the driver, please refer to instructions accompanying the LAN adapter.
- Is your LAN adapter switched on?

Note
zz It may not be possible to establish a connection with the display if security (firewall) software or utility software for LAN
adapter are installed.
 “Frequently Asked Questions” (Page 63)
Operation
is not guaranteed for all LAN adapters and built-in LAN adapters in the computers.
zz
zz An Internet connection is required to activate a display.
When using a serial (RS‑232C) cable
Computer equipped with a serial (RS‑232C) port
- Is your serial (RS-232C) function switched on?
Computer not equipped with a serial (RS‑232C) port
- Use a USB-RS-232C converter.
Please install the USB-RS-232C converter driver beforehand.
For details on how to install the driver, please refer to instructions accompanying the USB-RS-232C converter.
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Installing/Uninstalling Software
Installation
Quit any applications running in Windows before starting installation. Failure to do so may result in improper installation.
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Download this software (Video Wall Adjustment & Calibration Software).
Log in to PASS*1 on the website (https://panasonic.net/cns/prodisplays/pass/), click [Software Download], and follow the
on-screen instructions to download the software.
*1: PASS: Panasonic Professional Display and Projector Technical Support Website

2
3

4

Extract the file downloaded from PASS.
After the folder has been extracted, double-click “Setup.exe”.

Follow the on-screen instructions to install the application.
As soon as the installation process is completed, a shortcut icon is created on the desktop.
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Installing/Uninstalling Software

Note
zz If the same version of the software is already installed, the following screen appears.

To repair defects in the software, select “Repair Video Wall Manager” and click [Finish].
To uninstall the software before installing it again, select “Remove Video Wall Manager” and click [Finish].
zz If you selected “Repair Video Wall Manager” and the “Insert disk” message is displayed, uninstall the application, and
then reinstall it.
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Installing/Uninstalling Software

Software Uninstall
Windows 11 / Windows 10
Enter and select “Apps & features” in the search box in the taskbar, select [Video Wall Manager], and click [Uninstall].
Windows 8.1
Press [X] while holding down the [Windows logo] key on the keyboard. Select [Video Wall Manager] from [Control Panel] →
[Uninstall a program], and click [Uninstall].
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Preparation
 Displays supported
For details on models compatible with the Video Wall Adjustment & Calibration Software, check the information found on the
software download page after logging in to PASS on the website (https://panasonic.net/cns/prodisplays/pass/).

Note
zz No guarantees are made for the operations when the computer is connected to a non-supported display.

 Connecting the display to a computer
One uses a LAN connection and the other uses a serial connection.
Displays with a LAN connection and serial connection cannot be managed simultaneously.
LAN connection
zz Use a LAN cable to connect the display to the computer.
Up to 100 displays can be connected. When using the Auto Display Adjustment function, up to 25 of these displays can be
adjusted at the same time (up to 5 horizontal, up to 5 vertical).
zz If a DIGITAL LINK OUT terminal is available on the displays and a LAN connection is used with the DIGITAL LINK OUT
terminal, multiple displays can be connected in sequence to a display that is connected to a single computer (daisy chain
connection).

Note
zz This software does not support LAN connection with TH-55LFV9, TH-55LFV8, TH-49LFV8, TH-55LFV50, TH-55LFV5,
and TH-47LFV5.
zz When using a hub to connect, whether or not a straight cable or crossing cable or both can be used depends on the system
configuration. Please consult your network administrator for details.
zz The number of connected units will be limited when creating a daisy chain connection using a DIGITAL LINK OUT terminal.
For details on how to handle control when using a daisy chain connection, check display and twisted pair cable transmitter
user manuals.
Serial (RS-232C) connection
zz Using a serial cable, connect multiple displays to a display connected to a single computer (daisy chain connection).
Up to 100 displays can be connected. When using the Auto Display Adjustment function, up to 25 of these displays can be
adjusted at the same time (up to 5 horizontal, up to 5 vertical).

Note
zz Use a cable complying with the RS-232C standard as the serial cable. Refer to operating instructions of the display for
details on which type of cable can be used.
zz When using models TH-55LFV50, TH-55LFV5, or TH-47LFV5, up to 25 displays can be connected.
zz For details how to connect when controlling using a daisy chain connection, refer to the operating instructions of the display.
zz Specify values between 1 and 100 when configuring the display ID setting. Displays specified as 101 or above will not be
recognized.
zz A display without a SERIAL OUT terminal cannot be connected in a daisy chain.
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Preparation

 Setting the Computer
Network settings for a LAN connection
zz See the following when using displays other than TH-55LFV9, TH-55LFV8, TH-49LFV8, TH-55LFV50, TH-55LFV5, and
TH-47LFV5.
- Set the IP ADDRESS, SUBNET MASK and DEFAULT GATEWAY according to the operating environment. (Please
consult your network administrator for details.)
Port settings for a serial (RS-232C) connection
zz Because communication is automatic, communication speed settings do not need to be adjusted.

 Setting the Display
Network settings for a LAN connection
zz When using a LAN connection, display settings must be adjusted to match the network environment.

Note
zz This software does not support LAN connection with TH-55LFV9, TH-55LFV8, TH-49LFV8, TH-55LFV50, TH-55LFV5,
and TH-47LFV5.
zz Refer to operating instructions of the display for method on configuring the display.
zz This software identifies the display using the configured IP address. If DHCP is set to ON in the display network setting in a
network environment that uses a DHCP server etc., the DHCP server may change the IP address allocated to the display,
making it impossible to connect using this software.
Port settings for a serial (RS-232C) connection
zz When using a serial (RS-232C) connection, the serial port control settings must be adjusted.

Note
zz Refer to operating instructions of the display for method on configuring the display.

 Connecting to a Color Sensor
Use a color sensor when calibrating the display.
Use a USB cable to connect a computer and color sensor.
Use the USB cable included with the color sensor or the manufacturer recommended USB cable for your color sensor.
For information on compatible color sensors, see “Calibration Screen” (page 47).

 Camera connection
To use the Auto Display Adjustment function, prepare a camera.
Use a USB cable to connect a computer and camera.
Use the USB cable included with the camera or the manufacturer recommended USB cable for your camera.
For details on compatible cameras and lenses, check the information found on the software download page after logging in to
PASS on the website (https://panasonic.net/cns/prodisplays/pass/).
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Starting and Exiting the Application
Starting the application
Double-click the shortcut icon on the desktop.
When the application starts, the [Connection Setting] screen appears.
Select the display model and connection method.

 Model No.
Select the display to be connected from the display list in the tab or pull-down menu.

Note
zz Displays of different series cannot be connected simultaneously.
zz Even if displays are in the same series, they cannot be connected simultaneously if they are different models (SF1H and
SF2H, etc.).
zz If you are using the LFV or EF series, displays of different sizes cannot be connected simultaneously.

 LAN / RS-232C
Select the display and computer connection method.
To use a LAN connection for the display and computer, select the [LAN] tab; alternatively, to use a serial (RS-232C)
connection, select the [RS-232C] tab.

Note
zz This software does not support LAN connection with TH-55LFV9, TH-55LFV8, TH-49LFV8, TH-55LFV50, TH-55LFV5,
and TH-47LFV5.
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Starting and Exiting the Application

[LAN]

To use a LAN connection, select the [LAN] tab and adjust the following settings.

⑦

①
②
③

A Start IP Address
Input here the IP address of the display to be connected.
To search for a connected display, enter an IP address to start
searching.
The default value is the smallest host address in the same
network as the IP address configured for the network card of
the computer on which the software is installed.
Ex.: When the computer IP address is 192.168.0.10, the
default value is 192.168.0.1.
The last value used the previous time will be used each time
the software is launched.
B End IP Address
To search for a connected display, select the check box and
enter an IP address to end searching.

Note

④

⑤

⑥

zz Specify the same network address for the “Start IP Address”
and “End IP Address”.
Ex.: If 192.168.0.6 is entered in “Start IP Address”, in “End IP
Address”, enter an IP address that is the same as “Start
IP Address” up until 192.168.0.
C Port
Set here the number of the port that is to be connected to the
display.
The default value is 1024.
D User Name, Password
Enter a user name with administrator privileges to connect with
the display and its password.
Under the factory default settings of the display, the user name
is “dispadmin” (or “admin1”) and the password is “@Panasonic”
(or “panasonic”).
The user name and password differ depending on the display
model so please check the operating instructions for your
display.
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Starting and Exiting the Application

E Auto Power ON
To search for a connected display, select the check box.
When the check box is selected, [Auto Power ON] is enabled,
and if you click [Search], the power for all displays in the search
area will be set to “On”.

Note

⑦

①
②
③
④

⑤

⑥

zz If the main power for the display is not on, the power for the
display cannot be set to “On” using [Auto Power ON].
zz The specified displays will be connected when you click [OK],
however, if the display power is not set to “On”, you will not be
able to connect.
zz If [Auto Power ON] is enabled and displays available for
connection are detected using the search function, the power
will be set to “On” even if you do not specify a display for
connection.
F [Search]
Use this to search for displays available for connection. Click to
begin searching.

Note
zz Before carrying out a search, make sure that the main power
is on for the applicable displays. If the main power is not on,
the displays will not be available for searching.
zz If the model selected in [Model No.] differs than the display
or projector on the same network it will be detected, but
connection will not be possible.
G Display connection list
The IP address list for displays detected during a search
appears highlighted in blue.
Click the displays you will not connect to to remove the highlight.
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Starting and Exiting the Application

[RS-232C]

To use a serial (RS-232C) connection, select the [RS-232C] tab and adjust the following settings.
A Start Display ID
Specify the display ID for connection.
To search for a connected display, specify the display ID to
start searching.
The default value is 1 or the last value used the previous time.

Note

⑥

①
②
③

④

⑤

zz Search will not be performed if the display ID is set to “0”.
Configure a display ID number from 1 to 100 for the display
beforehand.
B End Display ID
To search for a connected display, select the check box and
specify the display ID to end searching.
C Port
Specify here the number of the RS-232C port that is to be
connected to the display.
The computer COM port is automatically detected and
available options only are displayed.
Select a COM port from the pull-down menu.
The default value is the smallest detected COM port.
The selected COM port is stored in memory.

Note
zz If a COM port is not displayed, COM ports are disabled.
Check to make sure the serial (RS-232C) port on your
computer is enabled.
D Auto Power ON
To search for a connected display, select the check box.
When the check box is selected, [Auto Power ON] is enabled,
and if you click [Search], the power for all displays in the
search area will be set to “On”.

Note
zz If the main power for the display is not on, the power for the
display cannot be set to “On” using [Auto Power ON].
zz The specified displays will be connected when you click
[OK], however, if the display power is not set to “On”, you will
not be able to connect.
zz When using a TH-55LFV9, TH-55LFV8 or TH-49LFV8, [Eco
Mode] must be set to [Normal] for the display to allow its
power to be turned “On” via the [Auto Power ON] function.
zz If [Auto Power ON] is enabled and displays available for
connection are detected using the search function, the
power will be set to “On” even if you do not specify a display
for connection.
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E [Search]
Use this to search for displays available for connection. Click to
begin searching.

Note

⑥

①
②

zz Before carrying out a search, make sure that the main power
is on for the applicable displays. If the main power is not on,
the displays will not be available for searching.
F Display connection list
The ID list for displays detected during a search appears
highlighted in blue.
Click the displays you will not connect to to remove the highlight.

③

④

⑤

 OK / Cancel
Click [OK] to connect to the specified displays and display the main
screen.
When [Cancel] is clicked, the application is exited without establishing
a connection.

Note
zz Before clicking [OK], make sure that the power for the applicable
displays are set to “On”. Connection is not possible when the power
is not set to “On”.
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Starting and Exiting the Application

 [Option] menu
The following items can be set in the [Option] menu at the top left of the screen.
A [Display ID Auto Setup]
ID assignment to individual displays for control can be carried
out automatically.
The first display and computer connection in the daisy chain
can use a LAN connection or serial (RS-232C) connection.
 “[Display ID Auto Setup] - [LAN]” (page 18)
 “[Display ID Auto Setup] - [RS-232C]” (page 19)

①
②
④

③

Note
zz This function may not be available on some models.
zz Refer to operating manual of the display for details on how to
use the automatic ID assignment function for displays.
B [LAN Setup by RS232C]
Configure LAN settings for displays using a serial (RS-232C)
connection.
 “LAN Setup by RS232C” (page 20)

Note
zz When TH-47LFV5, TH-55LFV5, TH-55LFV50, TH-49LFV8,
TH-55LFV8, TH-55LFV9, TH-42AF1, TH-49AF1, or TH-55AF1
displays are selected, the menu is grayed out and cannot be
selected.
C [Service Password]
This menu is used to support maintenance. It is not normally
used.
D [Version]
This is where the application’s version information can be checked.
The activation status is also displayed.
 “Activation” (page 22)

 [Activation] menu

②

①

A [Export the Volume Serial Number]
This creates a Volume Serial file (file registered to PASS). This
file is required to acquire the activation code file.
 “Activation” (page 22)
B [Activate Software License]
This activates the software.
zzAn activate code file or activation code are required.
 “Activation” (page 22)
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Starting and Exiting the Application

Display ID Auto Setup - [LAN]

Select the [LAN] tab and adjust settings for the displays connected via LAN.
IP Address
Input here the IP address of the display to be connected.
The default value is the smallest host address in the same
network as the IP address configured for the network card of
the computer on which the software is installed.
Ex.: When the computer IP address is 192.168.0.10, the
default value is 192.168.0.1.
The value stored in memory will be used each time the
software is launched.
Port
Set here the number of the port that is to be connected to the
display.
The default value is 1024.
User Name, Password
Enter a user name with administrator privileges to connect
with the display and its password.
Under the factory default settings of the display, the user
name is “dispadmin” (or “admin1”) and the password is “@
Panasonic” (or “panasonic”).
The user name and password differ depending on the display
model so please check the operating instructions for your
display.
Display ID
Select from the pull-down menu to assign an ID to a display.
You can select from 1 to 100.

Note
zz When using a daisy chain connection to control displays,
the display ID is assigned to the first unit in the daisy chain.
Changing Network Control
Select whether or not you want to change network control.
Default setting is “Yes”.
Changing Serial/IR Terminal
Select whether to change settings for serial or remote control
via DIGITAL LINK.
Default setting is “Yes”.

Note
zz This appears when using TH-55LFV70, TH-55VF1H,
TH-55VF2H or TH-55VF2 displays.
[Start]
When this is clicked, the display ID is automatically assigned.
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Display ID Auto Setup - [RS-232C]

Adjust settings for displays with a serial (RS-232C) connection.
Port
Specify here the number of the RS-232C port that is to be
connected to the display.
The computer COM port is automatically detected and
available options only are displayed.
Select a COM port from the pull-down menu.
The default value is the smallest detected COM port.
The selected COM port is stored in memory.

Note
zz If a COM port is not displayed, COM ports are disabled.
Check to make sure the serial (RS-232C) port on your
computer is enabled.
Display ID
Select from the pull-down menu to assign an ID to a display.
You can select from 1 to 100.

Note
zz When using a daisy chain connection to control displays, the
display ID is assigned to the first unit in the daisy chain.
Changing Network Control
Select whether or not you want to change network control.
Default setting is “Yes”.
Changing Serial/IR Terminal
Select whether to change settings for serial or remote control
via DIGITAL LINK.
Default setting is “Yes”.

Note
zz This appears when using TH-55LFV70, TH-55VF1H,
TH-55VF2H or TH-55VF2 displays.
[Start]
When this is clicked, the display ID is automatically assigned.
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LAN Setup by RS232C

Configure LAN settings for displays using a serial (RS-232C) connection.

Note
zz When TH-47LFV5, TH-55LFV5, TH-55LFV50, TH-49LFV8, TH-55LFV8, TH-55LFV9, TH-42AF1, TH-49AF1, or
TH-55AF1 displays are selected, the menu is grayed out and cannot be selected.

⑥

①
②

④

③

⑤

A Port
Select the serial (RS-232C) connection port.
The default setting is the COM port number selected in the connection dialog box.
B Display ID
Specify the Display ID to configure.
You can specify a value from 1 to 100.
The default setting is 1. On subsequent startups, the default setting will be the previously specified value.
C LAN Setting
Specify the IP Address, Subnet Mask, Gateway, and DHCP settings.
The default settings are as follows.
IP Address: 192.168.0.8
Subnet Mask: 255.255.255.0
Gateway: 192.168.0.1
DHCP: OFF
On subsequent startups, the default settings will be the previously specified values.
You can specify a value from 0 to 255 for the address.
D Apply
Applies the configured LAN settings to the specified Display ID.
If application of the settings fails, an error message will appear. Follow the instructions on the screens in such cases.
E Increment Display ID and IP Address automatically
When this check box is selected, the Display ID and IP Address settings increase in increments of 1 each time Apply is
executed successfully.
Example: Display ID increments: 1 → 2, 2 → 3 … 100 → 1
IP Address increments: 192.168.0.8 → 192.168.0.9 … 192.168.0.254 → 192.168.0.2

Note
zz Only the fourth octet of the IP Address increases incrementally.
zz The IP Address increments will not change the values to 0, 1, or 255.
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F Applied IP Address List
Lists the IDs and IP Addresses that were configured successfully after executing Apply.
Example: ID:001 IP:192.168.000.010
If the settings were configured with DHCP set to ON, the display will be as follows.
ID:001 DHCP:ON

Note
zz The displayed list is stored for only as long as the screen is displayed.

Exiting the application
To exit the main screen, either select [Exit] from [File] menu or click the
button at the top right of the window.
To exit the [Connection Settings] screen, either click the [Cancel] button or click the
button at the top right of the window.
zz When clicked, a confirmation message appears. Proceed with operation as instructed in the message.
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Activation
By activating this software, its functions are expanded, you can use externally-connected cameras, and automatically adjust
the color and brightness across multiple displays that make a Multi Screen Display.

Note
zz Auto Display Adjustment Upgrade Kit (TY-VUK10) is required for activation. For details on compatible display models, check the
information found on the activation page by logging in to PASS on the website (https://panasonic.net/cns/prodisplays/pass/).
zz There are two trial periods (24 hours each) for using the Auto Display Adjustment function of the software after installing the
software. If you click the [AUTO ADJUST] button during a trial period, a message will appear*1.
After the trial periods have ended, purchase the Auto Display Adjustment Upgrade Kit (TY-VUK10) and activate this
software.
*1: The 24 hour count begins once you click [OK] on the confirmation screen for starting the trial period.
If you click the [AUTO ADJUST] button during a trial period, the following screen appears.

This appears as “2” during the first trial period and
as “1” during the second trial period.
The remaining time is displayed.

Perform the display activation

1

Have the key code ready.

Computer
installed the
software

Have the key code label ready for the Auto Display Adjustment Upgrade Kit (TY-VUK10).
Key code

2

Start the software application, and display the [Connection Setting] screen or the main screen.

3

From the [Activation] menu, select [Export the Volume Serial Number].

 “Starting the application” (page 12)
 “Main Screen” (page 27)

The [Input Key Code] screen will appear.
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4

In the [Input Key Code] screen, enter the key code shown on the key code label.
The key code is a 25 character single-byte alphanumeric code. All letters should be capitalized, and 5 characters should
be entered for each box.

Click [OK] to display the file save screen.

5

Save the Volume Serial file (“SERIAL.LST”) to any location.
Key code

Volume serial file

SERIAL.LST
or
Volume serial number

You can change the file name, however, the file extension (.LST) should not be changed.
To return to the [Input Key Code] screen, click [Cancel].
When file saving is complete, the [Input key Code] screen closes.

23

Activation

Once the file has been saved, the Volume Serial Number (20 single-byte alphanumeric characters) will appear in the [Input
Key Code] screen.
For further steps, if you manually enter the Volume Serial Number and download the activation code file, write down the
code and keep it until activation is complete.

Note
zz Always use the most recent versions of the Volume Serial file and Volume Serial Number used to download the activation
code file.

6
7

Launch a web browser, log in to PASS on the website (https://panasonic.net/cns/prodisplays/pass/), and click the
[Activation] button on the side of the member top page.
Download the activation code file.
Download the activation code file (“ACTIVE.LST”) using
one of the following two methods.
Volume serial file

Activation code file

SERIAL.LST

ACTIVE.LST

or
Volume serial number

or
Activation code

Key code

When using a Volume Serial file (default name: SERIAL.LST)
Follow the on-screen instructions to upload the Volume Serial file to PASS, and enter the key code to download the
activation code file (“ACTIVE.LST”) to any loacation.
zz The activation code file name can be changed, however, the file extension (.LST) should not be changed.
zz After downloading the activation code file, the activation code (30 character single-byte alphanumeric code) appears,
however, when using the activation code file to activate the software, the activation code is not used. If you enter the
activation code manually when activating the software, write down the code and keep it until activation is complete.
When manually entering the Volume Serial Number
Follow the on-screen instructions to register the Volume Serial Number to PASS, and enter the key code to download the
activation code file (“ACTIVE.LST”).
zz The Volume Serial Number is a 20 character single-byte alphanumeric code. All letters should be capitalized, and 5
characters should be entered for each box.
zz The activation code file name can be changed, however, the file extension (.LST) should not be changed.
zz After downloading the activation code file, the activation code (30 character single-byte alphanumeric code) appears.
For further steps, if you enter the activation code manually when activating the software, write down the code and keep it
until activation is complete. When using the activation code file to activate the software, the activation code is not used.
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8

Perform the display activation.
Activate the software (“ACTIVE.LST”) using one of the following two methods.

Activation code file

ACTIVE.LST
or
Activation code

When using the activation code file (default name: ACTIVE.LST)
1) From the [Activation] menu of the [Connection Setting] screen or the main screen, select [Activate Software License]
and click the [By import “Activation Code” file] button.

2) Select the activation code file (default name: ACTIVE.LST) downloaded from PASS and click [Open].
zz To return to the previous screen, click [Cancel].
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When manually entering the activation code
1) From the [Activation] menu of the [Connection Setting] screen or the main screen, select [Activate Software License]
and click the [By entering “Activation Code”] button.

2) After downloading the activation code file, enter the final 13 characters in the displayed activation code.
zz The activation code consists of 30 single-byte alphanumeric characters. All letters should be capitalized, 3 characters
should be entered for the first box of the last 13 characters, and 5 characters for the remaining boxes.

9

When activation (authentication) is complete, the activation code is registered to the software.
When the confirmation message appears, click [OK] to close it.

Note
zz If activation fails, check the following items.
- Does the key code entered in the [Input Key Code] screen in step 4 match the key codes entered when the Volume Serial
file (default name: SERIAL.LST) was uploaded to PASS or when the Volume Serial Number was registered to PASS?
- Does the Volume Serial file and Volume Serial Number created in step 5 match the Volume Serial file uploaded to PASS
when creating the activation code or the Volume Serial Number entered when registering to PASS?
zz Once activation is complete, the [AUTO ADJUST] (Auto Display Adjustment) button on the upper right of the Video Wall
Adjustment & Calibration Software (Video Wall Manager) main screen is enabled.
The [AUTO ADJUST] (Auto Display Adjustment) button is enabled during the trial period.
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Main screen
The main screen consists of the menu bar, tool bar, common operation area, adjustment area, and [AUTO ADJUST] (auto
display adjustment) button.
Adjustment area

[AUTO ADJUST]
(Auto Display Adjustment) button

Menu bar
Tool bar

Common operation
area

Note
zz When using this application, keep the main power of the display in the “on” setting.
zz When the display is in standby, only the “Display Control” [Power ON] will function.
zz If the display settings have been changed using a remote control, for instance, while using this software, the software and
display settings may not match.
zz You can click the tabs in the adjustment area to switch between screens and perform various adjustments and operations.
The screens that appear when you click the tabs are referred to as “editing mode.”
zz When using a model equipped with the [Schedule play function] for the USB media player, set the function to [Disable].
Proper adjustment may not be possible if this is set to [Enable].
zz When you are using a TH-55LFV9, TH-55LFV8 or TH-49LFV8 and want to view a setting via the display’s OSD, display the
OSD after changing the settings with the software.
If you displayed the OSD while you were changing the settings with the software, turn the OSD off before redisplaying the
OSD you want to view.
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Menu bar
The following main menus are displayed in the menu bar.

 [File] menu
[Reset to Factory Adjustment Picture Setting]
This returns all values set in the [Picture Adjustment] screen to the factory default settings for the display.
zz When this is clicked, a confirmation message appears. Proceed with operation as instructed in the message.

Note
zz This is not displayed when using TH-55LFV9, TH-55LFV8, TH-49LFV8, TH-55LFV50, TH-55LFV5, or TH-47LFV5.
[Load Adjustment Data]
This loads setting files saved to the computer (file extension: dsi).
[Save Adjustment Data]
This saves entered settings or picture menu data to the computer.
The file name is automatically generated from the computer time stamp.
If only a single display has been selected, the display serial number is included at the beginning of the file name.
If multiple displays have been selected, file names begin with “vw”.
The adjustment data for all displays where auto display adjustment was used, along with IP addresses, user names and
passwords, are saved.
[Reload]
This cancels the settings currently being edited using the application, and loads the current settings from the display.
zz When this is clicked, a confirmation message appears. Proceed with operation as instructed in the message.
[Exit]
Exits the software.
zz When this is clicked, a confirmation message may appear. In this case, proceed with operation as instructed in the
message.

 [Edit] menu
[Undo]
This discards the software application and display settings currently being edited.
It returns these settings to the status before the setting data is sent.
[Redo]
This returns the settings to the ones before the Undo operation is performed.

Note
zz Undo and Redo can be used up to 8 times to redo settings adjusted in each adjustment area ( page 38) editing
mode.
zz The Undo and Redo logs are cleared if you switch to another editing mode or display.
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 [Activation] menu
This performs the same operation as the [Activation] menu of the [Connection Setting] screen.
[Export the Volume Serial Number]
This creates a Volume Serial file (file registered to PASS). This file is required to acquire the activation code file.
 “Activation” (page 22)
[Activate Software License]
This activates the software.
zz An activate code file or activation code are required.
 “Activation” (page 22)

 [Version] menu
[Version]
This displays the version information for this software (Video Wall Adjustment & Calibration Software).
The activation status is also displayed.

Tool bar
Common icons used in each editing mode appear in the tool bar.
For details on the icons used in each editing mode, refer to the description of the mode concerned.
Reset to Factory Adjustment Picture Setting
This performs the same operation as [Reset to Factory Adjustment Picture Setting] on the [File] menu.
Load Adjustment Data
This performs the same operation as [Load Adjustment Data] on the [File] menu.
Save Adjustment Data
This performs the same operation as [Save Adjustment Data] on the [File] menu.
Reload
This performs the same operation as [Reload] on the [File] menu.
Undo
This performs the same operation as [Undo] on the [Edit] menu.
Redo
This performs the same operation as [Redo] on the [Edit] menu.
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Common operation area
The common operation area houses the operations which can be used in all the editing modes.

②

A Display connection list
Connected display IDs (first three digits) and names appear in a
list.
Displays that appear reversed in blue text can be operated.
The names of displays that currently can be operated appear on
the right side of the editing mode tab in the display area.

③
①

④

⑤

⑥

Note
zz Multiple displays can be selected for operating simultaneously.
In this case, select the check box on the left for the name of the
display you want to operate.
However, selecting multiple displays for operation is limited to
“Display Control” and “Test Pattern Setting” options.
B [CHECK ALL]
This selects the check box on the left for all display names.
C [UNCHECK ALL]
This deselects the check box on the left for all display names.
However, the check box of the display highlighted in blue will
remain selected.
D [Add]
When this is clicked, the [Connection Setting] screen appears and
a new display can be added.
 “[Connection Setting] screen that appears when [Add] is
clicked” (page 34)
E [Del]
This disconnects the selected display and removes it from the
display connection list.
This cannot be selected when only a single display is running.
F [Rename]
This allows you to change the name of the selected display.
A name can consist of a maximum of 8 characters including letters
(upper-case), numbers, hyphens and periods.

Note
zz Up to 12 characters can be entered when using models
TH-55LFV9, TH-55LFV8, TH-49LFV8, TH-55LFV50,
TH-55LFV5, or TH-47LFV5.
However, because these models are not equipped with a
name setting function, changed names will only appear in this
software.
zz The software cannot be used to configure the name settings on
TH-42AF1, TH-49AF1, or TH-55AF1 displays. Changed names
will only appear in this software.
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G Status display
The status of the selected display is shown.
Model
This shows the model name.
Serial Number
This shows the serial number for the selected display.
Display
This shows the set ID for the selected display.

Note

⑦

⑧

zz This does not appear for LAN connections.
Horizontal Frequency
This shows the horizontal frequency for the currently displayed
signal.
Vertical Frequency
This shows the vertical frequency for the currently displayed
signal.
Used Time
This shows the time used for the display.
Version
This shows the firmware version of the display unit.
H [Multi Display Settings] (or [Tiling])
This shows the Multi Display Setting screen (or the Tiling screen)
to allow you to set the Multi Screen Display or Multi Input Display
layout and other settings.
Main screen operations can be performed even while the screen is
displayed.
 “Multi Display Settings screen (or Tiling screen)” (page 35)

Note
zz The screen title differs depending on the connected display
model, and may appear as “Multi Display Settings” or “Tiling”.
zz If the display unit does not support Multi Input Display, the
setting items for Multi Input Display are not displayed.
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I Display Control
You can carry out basic display operations.

Note
zz This item lets you select multiple displays for operating
simultaneously. In this case, select the check box on the left for
the name of the display you want to operate.
[Power ON]
When this is clicked, the power for all selected displays is set to
“On”.

Note
zz If the main power for the display is not on, the power for the
display cannot be set to “On” using this operation.
[Standby]
When this is clicked, all selected displays are switched to
standby.

Note
zz If the main power for the display is not on, the displays cannot
be switched to standby using this operation.
Input
Select Input from a pull-down menu.

Note
⑨

zz When the input is set to [Memory Viewer], [Calibration], [Color
Tone Adjustment], and [AUTO ADJUST] cannot be used.
zz If [Multi Input] is selected in Multi Display Settings, this item
cannot be selected.
Picture Menu (or Picture Mode or Picture Style)
Select a picture menu from a pull-down menu.

Note
zz When you are using a TH-55LFV9, TH-55LFV8 or
TH-49LFV8 and a PC signal is input to the DVI input
connector, PC input connector, or other connector on the
display, [Picture Style] cannot be selected. In addition, the
adjustment values displayed in the adjustment area will be
those for “PC” input.
Aspect
Select a picture size from a pull-down menu.

Note
zz This is not displayed when using TH-55LFV9, TH-55LFV8,
TH-49LFV8, TH-55LFV50, TH-55LFV5, or TH-47LFV5.
Onscreen Display
Enables or disables the display’s onscreen display.

Note
zz This is not displayed when using TH-55LFV9, TH-55LFV8,
TH-49LFV8, TH-55LFV50, TH-55LFV5, or TH-47LFV5.
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J Test Pattern Setting
Set a test pattern for showing on the display.

Note
zz This item lets you select multiple displays for operating
simultaneously. In this case, select the check box on the left for
the name of the display you want to operate.
When [Internal] is selected, the test pattern from the display is
used.
Available test patterns are as follows.
OFF, White, Red, Green, Blue, Cyan, Magenta, Yellow
The default value is OFF.
When [External] is selected, the test pattern from this software is
used.
Available test patterns are as follows.
OFF, White, Red, Green, Blue, Cyan, Magenta, Yellow, Color Bar
(Vertical), Color Bar (Horizontal), Gray Scale (Vertical), Gray Scale
(Horizontal), Cross Hatch1, Cross Hatch2
The default setting is OFF.

Note
zz A test pattern selected with this operation is used on the display
is not selected.
even if the check box for
zz When [Internal] is selected, the Cyan, Magenta, and Yellow test
patterns may not be available depending on the model.
zz To enable display of the computer screen on all of the displays
when using the [External] test pattern, the displays and
computer must be connected using video cables.
K Transfer to ********
The parameter changed in the adjustment area is transferred to the
display that appears reversed in blue text in the display connection
list.
When the
check box is selected, parameters are
automatically transferred to displays each time they are changed.
A check mark is entered as the default setting.

⑩

⑪

When the
check box is deselected, the [Manual
Transfer] button is enabled, and each time it is clicked, parameters
are transferred to displays.
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[Connection Setting] screen that appears when [Add] is clicked
When the [LAN] tab is selected, enter the IP address of the display to which you will connect.
When searching for connected displays, enter the IP address to start the search and IP address to end the search, select
the [Auto Power ON] check box, and click the [Search] button.
When the [RS-232C] tab is selected, enter the display ID of the display to which you will connect.
When searching for connected displays, enter the display ID to start the search and display ID to end the search, select
the [Auto Power ON] check box, and click the [Search] button.

When you click [OK], displays are added to the display connection list on the main screen.

Note
zz [Option] cannot be used. Also, the settings for connected displays in the the Model No., [LAN]/[RS-232C] tabs are
selected and cannot be changed.
zz Added displays available for connection appear after clicking [Add] to display the [Connection Setting] screen and
carrying out a display search .
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Multi Display Settings screen (or Tiling screen)
You can set the Multi Screen Display or Multi Input Display layout and other settings.
 “Multi Screen Display” (below)
 “Multi Input Display” (page 38)

Note
zz The selection items of Multi Screen Display and Multi Input Display are displayed only when they are supported by the
connected displays.
zz Multi Screen Display and Multi Input Display cannot be used simultaneously.
Multi Screen Display
You can set the Multi Screen Display layout and other settings. The following screen illustration shows an example of
when 4 displays are connected.

②

③

①

④
⑥

⑧

⑤

⑦

A Selection area
This shows the Multi Screen Display layout.
You can switch the display to operate by clicking the square representing each display. The frame of the selected
display is indicated in red.
The display ID is shown at the top left of each square.
The check box at the top right is linked with the display connection list check box in the common operation area. You
can only calibrate and adjust the picture for displays with a selected check box.
You can change the layout using a mouse. If you drag the square representing a display, it is switched with the display
in the location you drop it.
B Configure the layout of the Multi Screen Display.

Note
zz The items displayed may vary depending on the display model you are using.
Multi Display Setting
Select whether to configure the Multi Screen Display settings. The default setting is [OFF].
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Horizontal Scale (or H Displays)
Select the number of horizontal displays from the pull-down menu.
The default value is the number of displays selected in the check box of the display connection list.
Vertical Scale (or V Displays)
Select the number of vertical displays from the pull-down menu.
Display Orientation
Select the display orientation from the pull-down menu.
Landscape
This sets a landscape orientation.
Portrait
This sets a portrait orientation.
zz The orientation of the display’s OSD menu will be linked to this setting, depending on the model of the
connected display.
Frame Control
Configure the frame control function setting.
The setting value of each display will appear at the bottom left of the squares representing each display in the
selection area.
The default setting is [Auto].
Auto: FC=Auto
1: FC=1
2: FC=2
3: FC=3
When you click AutoSetup, the setting is set automatically as follows for each row. Auto setup is not used for row 7
and above. One horizontal row will have the same setting.
Displays on 1st row: FC=Auto
Displays on 2nd row: FC=1
Displays on 3rd row: FC=2
Displays on 4th row: FC=3
Displays on 5th row: FC=4
Displays on 6th row: FC=5
Reverse Scan
Configure the reverse scan function setting.
The setting value of each display will appear at the bottom left of the squares representing each display in the
selection area.
The default setting is [OFF].
OFF: RS=OFF
ON: RS=ON
When you click AutoSetup, ON and OFF are repeatedly set automatically as follows for each row. One horizontal row
will have the same setting.
Displays on 1st row: RS=OFF
Displays on 2nd row: RS=ON
Displays on 3rd row: RS=OFF
Displays on 4th row: RS=ON

Note
zz When [Frame Control] is set to [Auto], the reverse scan function will be disabled.
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C You can adjust the width of the vertical and horizontal bezel.
The items displayed will differ depending on the model of the display.
Bezel H Adjustment, Bezel V Adjustment

This adjusts the hidden image area in the junction between displays.
Setting values are available from 0 to 100.
“Bezel H Adjustment” adjusts the area in the horizontal direction, and “Bezel V Adjustment” adjusts the area in the
vertical direction.
Ex.:

When the value is set to 0

When the value is set to 100

Frame Comp.

You can select [ON] and [OFF] for the frame compensation function.
When [ON] is selected the bezel width of the display is compensated and appears in the following way.
Ex.:

[ON]

D [CHECK ALL]
This selects all the check boxes at the bottom right of the squares representing each display.
E [UNCHECK ALL]
This deselects all the check boxes at the bottom right of the squares representing each display. However, the check box
for the display around which the red frame is displayed will not be deselected.

Note
zz [CHECK ALL] and [UNCHECK ALL] are linked to the [CHECK ALL] and [UNCHECK ALL] buttons of the common
operation area.
F [Initialize]
This returns the Multi Screen Display layout settings and other settings adjusted in the Multi Display Settings screen (or
Tiling screen) to the default settings of this software.
G [Apply]
This applies the Multi Screen Display layout settings and other settings adjusted in the Multi Display Settings screen (or
Tiling screen) to the display.
H [Close]
This closes the screen without applying the Multi Screen Display layout settings and other settings adjusted in the Multi
Display Settings screen (or Tiling screen) to the display.
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Multi Input Display
You can set the layout and other settings for Multi Input Display.
The following screen illustration shows an example of when displaying the video of 4 input terminals.

②

③

①

⑤

④

A Selection area
This shows the Multi Input Display layout.
You can select the input terminal from the pull-down menu in each display.
B [Multi Input]
This allows you to select the display mode for Multi Input Display from the pull-down menu.
C [Sound]
This sets the sound output terminal to use with Multi Input Display.
D [Apply]
This applies the Multi Input Display layout and other settings to the display.
E [Close]
This closes the screen without applying the Multi Input Display layout and other settings to the display.

Adjustment area
Some of the operations using the display OSD menu can be performed using this software.

Note
zz The items that can be adjusted, setting details, and setting ranges vary depending on the display model. For details, refer to
the operating instructions of the displays.
You can click the tabs in the adjustment area to switch between screens and perform various adjustments and operations.
The screens that appear when you click the tabs are referred to as “editing mode.”
 “Picture Adjustment screen” (page 39), “Color Tone Adjustment screen” (page 42), “Other screen” (page 43),
“Remote screen” (page 46), “Calibration screen” (page 47)
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 Picture Adjustment screen
You can carry out menu operations for picture adjustment.

Note
zz The items that can be adjusted, setting details, and setting ranges vary depending on the display model.

①

②

③

④

A Picture Setting
You can adjust settings such as LCD panel backlight brightness, and picture color and density.
If you click the [Default] button, the settings for that item are returned to factory default settings.
The [Transfer] button is displayed when Color Temperature is set to User1 or User2. If you click the [Transfer] button, the
same settings are applied to all selected displays. In this case, from the display connection list, select the check boxes on
the left of the names of the displays you want to operate.

Note
zz The [Default] button is not available when using the TH-55LFV9, TH-55LFV8, TH-49LFV8, TH-55LFV50, TH-55LFV5, or
TH-47LFV5 model.
zz When you are using a TH-55LFV9, TH-55LFV8 or TH-49LFV8 and the display recognizes the input signal as "PC",
[Sharpness] cannot be adjusted.
zz The [Transfer] button may not be displayed depending on the display model.
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B White Balance Setting of ********
You can adjust the white balance of the picture.
The [Apply the other White Balance Setting] button and [Transfer] button are displayed when Color Temperature is set to
User1 or User2. Clicking the [Apply the other White Balance Setting] button displays the [Apply the other White Balance
Setting to User1] (“User2” when User2 is selected) screen.
If you click the [Transfer] button, the same settings are applied to all selected displays. In this case, from the display
connection list, select the check boxes on the left of the names of the displays you want to operate.

Color Temperature
Allows you to specify a different Color Temperature.
You can also enter a value directly. The setting range varies depending on the display model.
Copy to User2 setting to User1 or Copy to User1 setting to User2
Allows you to copy the setting values of the other User (e.g., the setting values of User2 when User1 is selected).
Click the [Apply] button to apply the settings. To close the screen without applying the settings, click the [Close]
button.
C Light ID Setting
Configure the light ID settings.
Light ID
Configure the transmission setting for the light ID. The default value is [External].
Backlight
Configure the backlight setting when the transmission setting for the light ID is set to [Internal] or External]. The
default value is [High].
D Dynamic Backlight Control
Configure the dynamic backlight control setting. The default value is [ON].

Note
zz The [Transfer] button may not be displayed depending on the display model.
zz [Light ID Setting] and [Dynamic Backlight Control] may not appear depending on the display model.
zz [Dynamic Backlight Control] cannot be configured when the transmission setting for the light ID is set to [Internal] or
[External].
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[Retouch]
You can perform fine white balance adjustment without having to specify each of the values for [White Balance Setting].

Select the Display to be retouched.
Select the display layout and the target display for fine adjustment.
For details on the [H Displays], [V Displays], and [Display Orientation] settings, see “Multi Display settings screen” (page 35).
Select the Best Retouch by pressing the each button.
Different fine adjustment preset values are assigned to [Retouch1] to [Retouch6]. When you click a button, the preset
values are applied to the selected display.
[Reset]
Reset the applied fine adjustment values.
Amount of Retouch
Select the amount of retouch fine adjustment.
You can select from [High], [Mid], or [Low].
[Finish]
Finish the retouch operation.

Note
zz While the [Retouch] window is open, only one of the [Retouch1] to [Retouch6] buttons can be applied for each display.

Note
zz “White Balance Setting” can be controlled with the software, however, control on the display itself may not be possible
depending on the display model.

41

Adjustment and Settings

Main Screen - Adjustment Area - Color Tone Adjustment

 Color Tone Adjustment screen
You can perform detailed color adjustment for the displays.

Note
zz This may not appear depending on the display model. Furthermore, some displayed items may be different.

Color Management
Configure the color management settings.
ON (6-Segment)
Select 6-Segment to enable 6-segment color management.
You can adjust the [Hue], [Saturation], and [Value] (brightness) for each color (red, yellow, green, cyan, blue,
magenta). The default value is 0.
You can reset settings to their default values for each color.
ON (12-Segment)
Select 12-Segment to enable 12-segment color management.
You can adjust Red, Yellow, Green, Cyan, Blue, and Magenta and their intermediate colors. The default value is 0.
Color Matching Function
Configure color matching settings.
You can configure the red, green, and blue components for each color (red, green, blue, cyan, magenta, yellow).
You can reset settings to their default values for each color.

Note
zz “Color Management” and “Color Matching Function” can be controlled with the software, however, this may not be possible
on the display itself depending on the display model. Settings that cannot be controlled on the display itself can be
configured using the software when the [Enable Editing] check box is selected.
zz 12-Segment is not displayed if it is not supported by your display model. For whether a display supports 12-Segment, refer
to the operating instructions for your display.
zz The [Enable Editing] check box will be located under [6-Segment Color Management] or [Color Matching Function]
depending on the display model.
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 Other screen
You can carry out some menu operations except for picture adjustment.

Note
zz The items displayed and items that can be adjusted, setting details, and setting ranges vary depending on the display
model.

③
④
⑤
⑥

①

⑦
②
⑧

⑨

Note
zz Items with a [Transfer] button let you select multiple displays for operating simultaneously. In this case, from the display
connection list, select the check box on the left for the name of the display you want to operate.
If you click the [Transfer] button, the same settings are applied to all selected displays. Settings are applied to each single
item from A to H in the figure above.
A Backup Input Settings
You can adjust backup input settings.
B Eco Mode Settings
You can adjust ECO mode settings.
C YUV/RGB-in Select
You can switch between the YUV/RGB signal mode.
D Digital Link Out Select
You can select a signal to output from the DIGITAL LINK OUT terminal.
E Power On Screen Delay
You can set the delay control for power on operation.
F OSD Language
You can switch the on-screen menu display language.
G Day/Time Settings or Date and Time Settings
You can set the current time and the current day or date.
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H Position
You can adjust the screen position.
I Sound
You can switch between ON (enabled) and OFF (disabled) for the mute function.

44

Adjustment and Settings

Main Screen - Adjustment Area - Other

When using TH-55LFV50, TH-55LFV5, or TH-47LFV5

Screen Setting
You can adjust screen settings.
Audio Setting
You can adjust the audio.
Remote Control
You can select remote control operation mode.
Console Button Control
When you select “Normal” buttons can be operated on the display itself, however, if “Lock” is selected, buttons on the
display cannot be operated.

Note
zz This setting item is not available on the display.
Initial Input
You can set the input terminal for when the power is set to “ON”.

45

Adjustment and Settings

Main Screen - Adjustment Area - Remote

 Remote screen
You can perform remote control and command control operations with the software.

Note
zz This setting item may not be displayed depending on the display model.

Remote Control
You can control OSD operations for the displays using the buttons on the software.
Command Control
You can control the displays using command inputs.
When [Enable] is selected, command input is enabled.
You can enter commands directly into the [Command] field using the keyboard. The command is sent to the display when
you click [Send].
The response from the display appears in the [Response] field.
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 Calibration screen
Using a color sensor, you can adjust the gamma and white balance of the display in this screen.

Note
zz This setting item may not be displayed depending on the display model.
zz When using the TH-55LFV50, TH-55LFV5, or TH-47LFV5 model, the display and computer must be connected using a
video cable to enable display of the computer screen on the Multi Screen Display.
zz Use a color sensor when calibrating the display.
zz Before connecting a color sensor, drivers or software for the color sensor must be installed on the computer where the
Video Wall Adjustment & Calibration Software is installed. Refer to the color sensor user guide during installation.
zz No guarantees are made for the operations when the computer is connected to a non-supported color sensor.
Supported color sensors are as follows.
Spyder4, Spyder5 and SpyderX
This color sensor is manufactured by Datacolor.
CA-210, CA-310 and CA-410
This color sensor/analyzer is manufactured by Konica Minolta.
i1-Pro2
This color sensor is manufactured by X-Rite.

Note
zz When using the Spyder4, Spyder5 or SpyderX color sensor, do not launch the software supplied with the Spyder4, Spyder5
or SpyderX while using the Video Wall Adjustment & Calibration Software. If it is running, shut it down.
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Color Sensor Setting
You can adjust color sensor settings.
[Color Sensor]
Select the color sensor from the pull-down menu.

Note
zz For details on color sensor handling, refer to the color sensor user guide.
zz Calibration cannot be performed on display models equipped with the light ID function for which [Light ID Setting] is
set to [External] or [Internal]. Be sure to set [Light ID Setting] to [OFF].
[Connect]
Click this to check the color sensor connection.
You can check the color sensor connection status in the Status field.
Connected: The color sensor is connected.
Not Connected: The color sensor is not connected.
[Zero Calibration]
Click this to zero (all black) the color sensor calibration.
Before clicking this button, ensure light is not entering the color sensor.
The zeroing (all black) calibration status appears in the Status field.
Performed: Zeroing (all black) calibration is complete.
Not Performed: Zeroing (all black) calibration is incomplete.

Note
zz Because the Spyder4, Spyder5 or SpyderX color sensor does not have a zeroing (all black) calibration function, this button is
disabled.
[Test Measurement]
When you click this, a separate window opens, and the color sensor performs measurement in sequence.
Measurement parameters are as follows.
Luminance, chromaticity: x, y, duv, and color temperature
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Main Screen - Adjustment Area - Calibration

Note
zz Operations in the main screen are disabled during test measurement.
Luminance evaluation of selected display

Note
zz This is not displayed when using the TH-55LFV50, TH-55LFV5, or TH-47LFV5.
This evaluates the brightness of the selected display.
Displays in the connected display list that are highlighted in blue can be operated.
[Estimate the max luminance at 9300K]
Estimate the maximum luminance for when the color temperature is 9300K. When this is clicked, follow the steps in
the window that appears to take a measurement.
The measurement results are displayed in the right window.
Measured results are retained for each display until you exit the software.
Calibration Setting
This is used to set the calibration reference value.
[By Measuring the Selected Display]
This is used to set a specific display as a standard.
When this is clicked, follow the steps in the window that appears to take a measurement.
Click [Save Calibration Setting] to save the measured value.
[By Loading the Calibration Setting]
Use this to apply the reference value saved to the computer.
When this is clicked, a file selection screen appears. Select the reference value for the specific display obtained in the
above procedure (file extension: “.dsc”).
[By Adapting the Default Setting]
This sets the software's default values.
[Save Calibration Setting]
This saves the Calibration Setting.
Target Luminance at 9300K
This sets the target luminance. Enter a numerical value.
The default setting varies depending on the model.
Selection of Gamma to be updated
Select a gamma setting for calibration.
The selected setting will be used for calibration.
The available gamma settings vary depending on the model.

Note
zz Multiple selections are possible, however, 2.2 is always selected and cannot be deselected.
Selection of Color Temperature Setting to be updated
Select a color temperature setting for calibration.
The selected setting will be used for calibration.
User1 and User2 can configure any color coordinate by entering coordinates.

Note
zz Multiple selections are possible, however, 9300K is always selected and cannot be deselected.
zz For TH-55LFV50, TH-55LFV5, or TH-47LFV5 displays, settings cannot be configured via coordinate entry by User1
and User2.
zz Generally, you can enter coordinates that are within the 2000 to 20000 k, duv=±0.02 color temperature range.
zz A confirmation message may appear. In such cases, follow the instructions in the message.
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Main Screen - AUTO ADJUST (Auto Display Adjustment) button

[Calibrate]
When this is clicked, calibration is carried out with the specified conditions.
Proceed with operation as instructed in the message.

Note
zz When using the TH-55LFV50, TH-55LFV5, or TH-47LFV5 model and “Picture Mode” is not set to [Standard], or when the
input is “PC”, “DVD/HD”, or “Video”, the [Calibration] button is disabled and calibration cannot be performed.
zz If the OSD menu does not appear after adjustment, set [Onscreen Display] to [ON] again in the common operation area.

AUTO ADJUST (Auto Display Adjustment) button
[AUTO ADJUST] button
Click the button to display the Auto Display Adjustment screen.
Using a camera and simple procedures, you can automatically adjust the color and brightness across multiple displays that
make a Multi Screen Display.
“Auto Display Adjustment” (page 51)


Note
zz The [AUTO ADJUST] (Auto Display Adjustment) button is enabled
during the trial period.
After installing the software, two trial periods (24 hours each) are
available for using the Auto Display Adjustment function of the
software. If you click the [AUTO ADJUST] button during a trial
period, a message will appear.
After the trial periods have ended, purchase the Auto Display
Adjustment Upgrade Kit (TY-VUK10) and activate this software.
 “Activation” (page 22)
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Using an externally-connected camera, you can automatically adjust the color and brightness across multiple displays that
make a Multi Screen Display.

Note
zz In order to use the Auto Display Adjustment function, you must first activate this software, and apply the “Auto Display
Adjustment Upgrade Kit (TY-VUK10)”.
 “Activation” (page 22)
In the [Version] menu, you can check the application status of the Auto Display Adjustment Upgrade Kit (TY-VUK10).
zz To use the Auto Display Adjustment function, prepare a camera.
zz When using Auto Display Adjustment, two or more displays for controlling with the software must be connected.
zz When using Multi Input Display, Auto Display Adjustment cannot be used.

Auto Display Adjustment Preparations
 Connecting to the display
Use a LAN cable or serial (RS-232C) cable to connect the display and computer.
 “LAN connection” (page 10)  “Serial (RS-232C) connection” (page 10)

Note
zz When using the TH-55LFV9, TH-55LFV8, TH-49LFV8, TH-55LFV50, TH-55LFV5, or TH-47LFV5 model, the display and
computer must be connected using a video cable to enable display of the computer screen on the Multi Screen Display.
zz Connection across displays that make a Multi Screen Display differ depending on the installation. For details, check with the
vendor who carried out the installation.

 Camera connection
Use a USB cable to connect a computer and camera.
For details on compatible cameras and lenses, check the information found on the software download page after logging in to
PASS on the website (https://panasonic.net/cns/prodisplays/pass/).

 Connection example

Computer

USB connection
LAN connection

Multi Screen Display

Camera

Note
zz To obtain optimal adjustment results, the camera should be placed face to face with the Multi Screen Display when using
Auto Display Adjustment. Adjustment is possible when the camera is facing the Multi Screen Display at an angle but may
fail if the angle is too large.
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Display Placement
When using the Auto Display Adjustment function, up to 25 displays (up to 5 horizontal, up to 5 vertical) can be adjusted at a
time.
Adjustment is possible for both landscape and portrait orientation. Adjustment is also possible when the installation mixes
landscape and portrait orientation.

Note
zz Even if the actual display installation mixes landscape and portrait orientation, set all displays as either landscape or portrait
for operating on the software screen, regardless of their actual orientation.
zz If the relative positional relationship of the displays and placement on the software screen differ, proper adjustment will not
be possible.
zz If displays are not placed in parallel, it may not be possible to adjust them correctly.
zz If the angle of the displays are not aligned, or part of a Multi Screen Display is missing, proper adjustment will not be
possible.
zz Proper adjustment may not be possible due to the surrounding environment, camera placement, and color luminance
distribution unique to the display. If adjustment is not performed properly, perform adjustments manually.

Examples of display placements not supported by the Auto Display Adjustment function

Displays are not placed side-to-side.

The corners of the displays do not
align.
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A part of a Multi Screen Display is
missing.

Auto Display Adjustment

Auto Display Adjustment Procedures
Settings for Auto Display Adjustment are configured in a wizard format.
While performing Auto Display Adjustment, a progress indicator will appear at the top right of each screen, allowing you to
check which step you are currently performing.
Progress indicator

Starting Auto Display Adjustment
Note
zz When using Auto Display Adjustment, make sure the power for all displays to be adjusted is on before starting. Proper
adjustment is not possible if some displays are not turned on or are in standby mode.
zz Make sure to use this function in an environment where you can minimize the effect of ambient light. If you can clearly see
reflections in the displays when looking from the camera position, proper adjustment may not be possible.
zz Auto display adjustment cannot be performed on displays for which “Picture Mode” is set to [DICOM]. To perform the
operation, switch to a different picture mode.
zz Auto Display Adjustment may not be available, depending on your model.

1

Click the [AUTO ADJUST] button in the main screen.

The display selection screen is displayed.

Note
zz After installing the software, two trial periods (24 hours each) are available for using the Auto Display Adjustment function
of the software. If you click the [AUTO ADJUST] button during a trial period, a message will appear.
After the trial periods have ended, purchase the Auto Display Adjustment Upgrade Kit (TY-VUK10) and activate this
software.
 “Activation” (page 22)
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Selecting Display

1

In the display selection screen, select displays to adjust.
Select the display to adjust from the frame on the left and click [Add] button.
The selected display appears in the frame on the right and becomes a target for adjustment.

Display selection screen
zz Click the [Add ALL] button to adjust all connected displays.
zz Click the [Test Pattern] button to display a test pattern on the displays selected in the left frame.
zz To remove a display as a target for adjustment, select the display in the frame on the right and click the [Del] button.
zz Click [Next] to proceed to the next step.
Click [Back] to close the display selection screen.

2

Click [Next].

Multi Screen Display Layout and Settings
You can set the Multi Screen Display layout and adjust other settings.

Note
zz Although the Multi Screen Display layout and settings configured in the main screen are applied to the Multi Screen Display
settings screen that appears in this auto display adjustment procedure, the layout and settings configured in this procedure
are not applied to the Multi Screen Display settings screen of the main screen. (i.e., Multi Screen Display layout and settings
are stored separately.)
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1

Select the number and orientation of displays that make a Multi Screen Display.
You can set up to 25 displays (up to 5 horizontal, up to 5 vertical).
From the Horizontal Scale (or H Displays) pull-down menu select the number of horizontal displays, and from the Vertical
Scale (or V Displays) pull-down menu select the number of vertical displays, then from the Display Orientation pull-down
menu select [Landscape] or [Portrait].

Multi Screen Display setting screen
zz Click the [Test Pattern] button to check if a test pattern appears on all displays.
zz You can switch the display to operate by clicking the square representing each display. The frame of the selected display
is indicated in red. The display ID is shown at the top left of each square.
z
z You can change the layout using a mouse. If you drag the square representing a display, it is switched with the display in
the location you drop it.
zz Main screen operations can be performed even while the Multi Screen Display setting screen is displayed.

Note
zz When [Portrait] is selected, the orientation of the display's OSD menu will be linked to this setting, depending on the
model of the connected display.
zz Displays where a test pattern does not appear are either turned off or in standby mode, and cannot be automatically
adjusted.
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2

Select whether or not you want to adjust the display based on a specific display as a reference.
If you select [Auto] in “Choose the target setting mode”, adjustment is carried out without setting a specific display.
If you select [Manual], the display is adjusted based on a specific display as a reference.

Multi Screen Display setting screen
zz When [Auto] is selected, the display is adjusted using “10700K” as a target.
zz You can configure the general brightness after adjustment by changing the [Luminance] setting.

Note
zz The setting range for the [Luminance] setting is 30% to 100%.
zz When using the TH-55LFV50, TH-55LFV5, or TH-47LFV5 model, the display is adjusted using “9300K” as a target.
zz When using TH-55LFV50, TH-55LFV5, or TH-47LFV5 displays and the “Color Temperature” configured in the
[Picture Adjustment] screen for the display targeted for [Manual] is 3000K, auto display adjustment cannot be
performed.
zz When using a TH-55LFV9, TH-55LFV8 or TH-49LFV8, the display is adjusted using “Normal” as a target.
zz When [Manual] is selected for using a specified display as a reference, select the reference display from the pull-down
menu.

3

Click [Apply].

Multi Screen Display setting screen
zz The settings in the Multi Screen Display setting screen are confirmed.
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4

Click [Next].
To return to the previous screen, click [Back].

Note
zz If you click [Apply] in the Multi Screen Display setting screen to confirm settings, they will be saved even if you click
[Back].

5

Select the input for applying Auto Display Adjustment results.
Select the check box of the desired input.
You can make multiple selections.

Input selection screen

Note
zz When using the TH-55LFV9, TH-55LFV8, TH-49LFV8, TH-55LFV50, TH-55LFV5, or TH-47LFV5 model, the
check box is always selected and cannot be cleared.

6

Click [Next].
To return to the previous screen, click [Back].
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Camera Setting

1

Check the camera connection.
When you click the [Connect Camera] button, the model name of the camera for which connection is verified appears.

Camera connection screen

Note
zz An error message appears if connection fails.
Check the following, and click the [Connect Camera] button again.
- The camera is properly connected.
- The camera is turned on.

2

Click [Next].

3

Adjust camera settings.

To return to the previous screen, click [Back].

Adjust the camera white balance, shutter speed, ISO, and F-number.

Camera setting screen
zz Click the [Auto Setup] button to automatically display a test pattern in the display and adjust settings.
If you select the [Manual Setup] check box, you can manually change the white balance, shutter speed, ISO, and
F-number. Select options from the pull-down menus.
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4

Capture a test shot.
A test shot is captured when you click the [Test Shot] button, and the captured image appears in the image display
window.
Verify that the entire Multi Screen Display to adjust fits within the image display window.

Image Display
window
[Test Shot]

Camera setting screen
zz To obtain optimal results, adjust the camera's position and zoom so that the entire Multi Screen Display to be adjusted
fills as much of the image display window as possible.

Note
zz If the entire Multi Screen Display to be adjusted does not fit properly within the image display window, adjustment will not
be performed properly.
zz An error message appears if camera configuration fails. In such cases, check the content of the message, click [OK], and
configure settings again.
zz If the area is too bright or there is a strong light present, overexposure may occur and adjustment may fail.

5

Click [Next].
To return to the previous screen, click [Back].

Note
zz When you click [Next], the display settings will change to those displayed on this screen.
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Auto Display Adjustment

1

Check the setting conditions for calibrating the gamma, etc.

Image setting confirmation screen
zz To return to the previous screen, click [Back].

2

Click [Start].
A progress bar appears, and Auto Display Adjustment starts.

Note
button at the upper right of the screen.
zz To stop Auto Display Adjustment, click [Cancel] or click the
When the
button is clicked, a confirmation screen appears. Click [OK] to end Auto Display Adjustment and click
[Cancel] to return to the original screen.
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3

A message indicating that Auto Display Adjustment is complete appears.

zz To exit Auto Display Adjustment, click [OK].
The adjustment results are applied to [Color Temperature] “User 1” (or “User”) in the [Picture Adjustment] screen.
zz When you click [After Retouch], the conditions from after fine adjustment are restored.
zz If Auto Display Adjustment could not be completed and must be performed again, an error message or error code will
appear. If the [Retry] button is available, click it to perform Auto Display Adjustment again.
Click [Finish] to exit Auto Display Adjustment.
For details on error messages and error codes, see “Error Messages and Codes” (page 62).
zz When you click the [Retouch] button, you can perform detailed white balance adjustments (page 40).
zz To reset the Multi Screen Display settings to their pre-adjustment state, click [Before Adjustment].
When you click [Before Adjustment], the pre-adjustment state is displayed in the Multi Screen Display. Click [OK] and
follow the on-screen instructions.
If you click [After Adjustment] after clicking [Before Adjustment], the conditions from after auto display adjustment are
restored. When you click [After Retouch], the conditions from after fine adjustment are restored.

Note
zz [Before Adjustment] and [After Adjustment] may take several tens of seconds for each display when using serial
(RS-232C) connections.
zz To adjust advanced settings after using Auto Display Adjustment, manually adjust each setting in the main screen.
zz The test pattern will be displayed as [External] when using the TH-55LFV50, TH-55LFV5, or TH-47LFV5 model, and as
[Internal] when using any other model.
zz After using Auto Display Adjustment, it is recommended that you click [Check ALL] in the main screen common operation
area, then click [File] and [Save Adjustment Data] in the main menu to save the adjustment data for all displays where
Auto Display Adjustment was used.
zz If you manually adjust settings after adjustment is complete, click the [Latest Adjust Result] button in the display selection
screen and select [Before Adjustment] to check the state displays were in before automatic adjustment was carried out.
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Error Messages and Codes
If Auto Display Adjustment could not be completed and must be performed again, an error message or error code will appear.
Check the following if an error message appears.
Cause

Solution

The brightness of the targeted display is too
high.

Click [Retry] to perform auto adjustment again.
Alternatively, click [Finish] to exit auto adjustment, manually adjust the
brightness of the target display, and then perform auto adjustment again.
zz When you click [Retry], adjustment is performed again after lowering the
brightness of the target display.

The brightness of the targeted display is too
low.

Manually raise the brightness of the target display, and perform auto
adjustment again.

The color temperature adjustments do not
converge.

Click [Retry] to perform auto adjustment again.
Alternatively, click [Finish] to exit auto adjustment, manually adjust the
color temperature, and then perform auto adjustment again.
zz When you click [Retry], adjustment is performed again while continuing
the convergence calculation.

The light emission cannot be measured
correctly.

Check the auto adjustment environment, and perform auto adjustment
again.
- Are all the displays to be adjusted displaying test patterns?
- Are there strong reflections that intrude intermittently?
- Is there an obstruction between the camera and the displays?

Check the following if an error code appears.
Error code

Cause / solution

107

An extremely bright light source exists within the shooting area of the camera.
zz Remove the light source.

118

The display area cannot be detected.
zz Remove any source of reflections.
zz Check that the entire Multi Screen Display to be adjusted fits within the image display window.

119

Image capture on the camera failed.
zz Remove any obstructions between the camera and the displays.
zz Do not manually change the focus, exposure, etc. during image capture.

121

Exposure adjustment on the camera failed.
zz Select the [Manual Setup] check box and reconfigure the F-number, ISO, and shutter speed settings in
the camera settings procedure.

125

Saving of the processing file failed.
zz Check the remaining capacity of the hard disk and the access privileges.

126

Communication with the display failed.
zz Check the connection between the display and the computer.

128

An error occurred on the camera.
zz Check the connection between the camera and the computer.
You can also try restarting the camera to reset camera operations.

62

Frequently Asked Questions
Check the following points once more before requesting repair.
Display is not recognized.
zz Has the display’s power been turned on?
zz Is the display supported by the software application?  “Displays supported” (page 10)
zz Have the units been connected properly?  “Preparation” (page 10)
zz Has the display’s network been set up correctly?  “Setting the Display” (page 11)
zz Has an attempt been made to connect 101 or more displays?
zz Is the display ID set to “0”?
zz Is the same display ID used for more than one display?
No connection can be made between my display and my computer
zz Has a Windows Firewall or other firewall been detected?
If a Windows Firewall has been detected
Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel] → [System and Security]
→ [Windows Firewall] → [Allow an app or feature through Windows Firewall] to see if this program is on the list.
Add the software to [Allow an app or feature through Windows Firewall].
Adding procedure
1.
2.
3.
4.
5.
6.
7.
8.

Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel].
When the <Control Panel> appears, click [System and Security] → [Allow an app through Windows Firewall].
When <Allow apps to communicate through Windows Firewall> appears, click [Change settings] → [Allow another app...].
When the <Add an app> dialog box appears, select [Video Wall Manager] and click [Add].
[Video Wall Manager] appears in the [Allowed apps and features] column.
Select the [Private] or [Public] network you want to allow connection to and click to select the check box.
Click [OK] in the <Allow apps to communicate through Windows Firewall>.
This software will now be added to the Windows firewall's exception list.

When non-Windows firewall has been detected
Are any firewall-containing applications installed?
If any applications which contain firewalls are installed, the installation may not complete.
(The firewall function may activate without launch of the application if the application has already been installed.)
If this occurs, firewall settings must be changed in order to allow connection to the network.
See the User’s Manuals for all applications containing firewalls to perform these settings.
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Messages that appear when an attempt to uninstall or update the software is made
zz Is the “Warning 1910. Could not ...” message displayed?
If an NVIDIA driver is installed on the computer, the following message may appear.

Click [OK] and continue the uninstallation or update procedures.
Although uninstalling the software will also temporarily remove the desktop shortcut icons, they will be regenerated
when you start up the computer next time. Manually delete the shortcut icons.
Files cannot be saved.
zz Has an attempt been made to save a file that includes values that exceed the range which can be set in the display?
zz Is there enough free memory on the hard disk?
zz Do you have the authority to access the folder in which the file is to be saved?
Part of the screen does not appear.
zz Depending on computer settings, part of the screen display may not work.
In this case, change the computer display settings to the display settings.
Picture adjustment cannot be performed.
zz Has an attempt been made to send display settings that includes values that exceed the range which can be set in the
display?
zz Has the display’s power been turned on?
Some items cannot be set if the display’s power is not on.
zz Are the display’s input connectors set correctly, and have the correct signals been input?
Some items cannot be set depending on the input connector settings, the types of signals input and whether or not
signals are present.
Cannot connect to the camera (Auto Display Adjustment).
zz Is the camera turned on?
zz Is the camera connected to the computer properly?
zz Is there a large number of data files stored on the SD card inserted in the camera?
If camera connection fails, try removing the SD card and performing the camera connection settings again.
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Trademarks
zz Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other
countries.
zz Other company names, product names or other names noted in this manual are trademarks or registered trademarks of the
respective companies. Note that ® and TM marks are not indicated in the text of this manual.

Note
zz Unauthorized use or reproduction of part or all of this software and manuals is strictly prohibited.
zz Panasonic Connect Co., Ltd. cannot be held liable for any effects resulting from the use of this software and manuals.
zz Panasonic Connect Co., Ltd. reserves the right to revise this software specifications and manual contents without notice.
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